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e² studio 2020-10 (R20200923-0905) 
Release Note 
Introduction 
This document outlines the device support, new features added in 2020-10, fixed issues and open issues in e² studio 
2020-07. 
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1. Product Information 
1.1 Online update for 2020-10 
 

NOTE:  

Updating e2 studio to 2020-10 from 2020-07 or 2020-04 using the built-in update system will prevent e2 studio from 
starting correctly if you have the Japanese or Chinese language packs installed. 

To fix an e2 studio in this state you need to run e2 studio on the command line using the "-clean" option once the update 
has been performed. (e.g. "e2studio.exe -clean") 

As a result of this the 2020-10 update will not be offered to 2020-07 users automatically. To update either use the 
installer to perform an upgrade or add "http://www2.renesas.eu/_custom/software/ree_eclipse/2020/2020-10/" as an 
update site within e2 studio then perform "Check for updates..." 

e2 studio will automatically restart after the update process. If this restart fails when using the update from the installer, 
please kill the e2 studio process from the Windows Task Manager. 

 

1.2 Supported Operating Systems 
These operating systems are officially supported by e2 studio: 

• Windows 8.1 64-bit 

• Windows 10 64-bit 

In addition, another official product build is available for Linux. This version supports: 

• Ubuntu 20.04 LTS 

No other Linux distributions are officially supported by e2 studio. 

e2 studio 2020-10 now runs on Java 11 & does not support older Java versions. 

 

1.2.1 Windows 64-bit product version 
 

Please note that 2020-04, 2020-07 and 2020-10 are 64-bit product build versions of the tool.  

We would like to state that the workspaces and projects from 7.x versions of e2 studio are fully compatible with 2020-
10.  

When opening a workspace from 7.x you will be shown a warning for and this is standard Eclipse behavior. This is 
shown because some metadata in the workspace can change between versions so a workspace will not always work 
with older versions of the tool. 

- Projects are forward & backward compatible, 
- Workspaces work when upgrading but it is not guaranteed to 100% work if you return the workspace to 7.8. 

 

The switch to 64-bit has unfortunately meant that some functions have now been deprecated from the tooling due to this 
move for the base platform. The removed functionality is listed below: 

• HEW Project Convertor 

• Renesas RTOS views 

• Mylyn integration 

• Subversion integration 

If you need this functionality then please remain on e2 studio 7.8. 

In addition, the Windows 64-bit installer no longer supports the RZ/G family of devices. This family is available in the 
e2 studio 7.8 installer.  
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The RZ/G family is available in the 7.8 installer and the Linux version of 2020-10. Linux tools are now only available 
in the Linux host version of e2 studio.  
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1.2.2 Linux version 
 

The Linux product version of e2 studio 2020-10 for Linux is based on the same content as the Windows release. 

 Therefore, documents of e2 studio will be helpful for common usages. There are some differences, the Linux version 
only supports the RA and RZ device families in 2020-10. 

For information on how to install the Linux product please refer to this section: 

6 - Linux version - How to install 
 
 
Device Family Windows Product Support Linux Product Support 

EC-1 Yes No 

RA Yes No 

RE Yes No 

RH850 Yes No 

RL78 Yes No 

RX Yes No 

RZ Yes (No Linux Hosted Tools) Yes 

RA Yes Yes 

Synergy Yes No 
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1.3 Supported Toolchains – Windows Hosted 
The following toolchains are supported in e² studio 2020-10. 

 
   Renesas GNU Arm  

Embedded (*2) 
Renesas GCC/  
GNURZ/ARM (*3) 

IAR (*4) Green Hills 
(*5) 

D
ev

ic
e 

Fa
m

ily
 

RL78 Yes (CC-RL) No Yes Yes No 

RX Yes (CC-RX) No Yes Yes No 

RH850 No No No Yes Yes 

RZ/ARM No No (*1) Yes Yes No 

Synergy/ARM No Yes No Yes No 

 RA/ARM No Yes No Yes No 

 RE/ARM No Yes No Yes No 
 
Note:  
*1: Project converter is available to convert from GNUARM RZ/none to GNU ARM Embedded toolchain. 

*2: The GCC toolchains for RZ Family and Renesas Synergy™ are distributed via  
Arm Developer at https://developer.arm.com/open-source/gnu-toolchain/gnu-rm  
or Launchpad.net at: https://launchpad.net/gcc-arm-embedded. They are also available using the 
“Additional components” page in the e² studio installer. Supported ARM GCC versions vary from device 
family to device family. Please see the following table for more information: 

 Device Family GCC distribution and version 

RZ/A1, A2 6.3.1 (2017 q2) 

RZ/G1, G2 Linaro 7.3.1 

Synergy SSP 1.6.x: 7.2.1 

SSP 1.7.x: 7.2.1 

RA FSP 1.1.0: 9.3.1 

 

*3: Legacy GNUARM toolchains are available from https://gcc-renesas.com/. In addition, the latest  
RX and RL78 Renesas GCC toolchains are available from this website. 

*4: The IAR toolchain plugins are available via the “Help”->” IAR Embedded Workbench plugin manager” 
menu in e2 studio. These Eclipse plugins are provided by IAR and are not supported by Renesas.  

*5: The Green Hills toolchain plugins are available within the e² studio product. These plugins are provided 
by Green Hills and are not supported by Renesas.  

  

https://developer.arm.com/open-source/gnu-toolchain/gnu-rm
https://launchpad.net/gcc-arm-embedded
https://gcc-renesas.com/
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1.4 Supported Toolchains – Linux Hosted 
The following toolchains are supported in e² studio 2020-10: 

• Linaro GCC – tested version 7.3.1-201805 
• GNU Arm Embedded – tested version 7.3.1.2018.06022 
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2. Device Support 
2.1 Project Generator Support – Windows Hosted 
Note: The Renesas SH device family is no longer supported in e2 studio. 

 

Family Group Devices 
EC-1 EC-1 R9A06G043 

RA 

RA2A1 R7FA2A1AB2CBT, R7FA2A1AB3CFJ, R7FA2A1AB3CFM, 
R7FA2A1AB3CNE, R7FA2A1AB3CNF 

RA4M1 
R7FA4M1AB2CLJ, R7FA4M1AB3CFL, R7FA4M1AB3CFM, 
R7FA4M1AB3CFP, R7FA4M1AB3CNB, R7FA4M1AB3CNE, 
R7FA4M1AB3CNF 

RA6M1 R7FA6M1AD2CLJ, R7FA6M1AD3CFM, R7FA6M1AD3CFP, 
R7FA6M1AD3CNB 

RA6M2 R7FA6M2AD2CLK, R7FA6M2AD3CFB, R7FA6M2AD3CFP, 
R7FA6M2AF2CLK, R7FA6M2AF3CFB, R7FA6M2AF3CFP 

RA6M3 

R7FA6M3AF2CBG, R7FA6M3AF2CLK, R7FA6M3AF3CFB, 
R7FA6M3AF3CFC, R7FA6M3AF3CFP, R7FA6M3AH2CBG, 
R7FA6M3AH2CLK, R7FA6M3AH3CFB, R7FA6M3AH3CFC, 
R7FA6M3AH3CFP 

RA4W1 R7FA4W1AD2CNG 

RA6M4 
R7FA6M4AF3CFB, R7FA6M4AF3CFP, R7FA6M4AF3CFM, 
R7FA6M4AE3CFB, R7FA6M4AE3CFP, R7FA6M4AE3CFM, 
R7FA6M4AD3CFB, R7FA6M4AD3CFP, R7FA6M4AD3CFM 

RE 

RE01_1500KB R7F0E014D2CFB, R7F0E014D2CFP, R7F0E015D2CFB, 
R7F0E015D2CFP, R7F0E016D2DBN, R7F0E017D2DBN 

RE01_256KB R7F0E01082CFM, R7F0E01082CFP, R7F0E01082DBH, R7F0E01082DBR, 
R7F0E01082DNG, R7F0E01182CFM, R7F0E01182CFP, 
R7F0E01182DBH, R7F0E01182DBR, R7F0E01182DNG 

RH850 

C1H R7F701260, R7F701270,(Debug Support Only) 
C1M R7F701263, R7F701271,(Debug Support Only) 
D1L1 R7F701401, R7F701421,(Debug Support Only) 
D1L2 R7F701402, R7F701422,(Debug Support Only) 
D1M1 R7F701404, R7F701405,(Debug Support Only) 

D1M1-V2 R7F701442, R7F701462,(Debug Support Only) 

D1M2 
R7F701408, R7F701410, R7F701428, R7F701430,(Debug Support Only) 

E1L R7F701201, R7F701205,(Debug Support Only) 
E1M-S R7F701202, R7F701204,(Debug Support Only) 

E1M-S2 R7F701215, R7F701216,(Debug Support Only) 
- R7F701Z05, R7F701Z06, R7F701Z07,(Debug Support Only) 

F1H R7F701501, R7F701502, R7F701503, R7F701506, R7F701507, 
R7F701508, R7F701511, R7F701512, R7F701513,(Debug Support Only) 

- 
R7F701521, R7F701522, R7F701524, R7F701525,(Debug Support Only) 
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F1K 
R7F701542, R7F701543, R7F701546, R7F701547, R7F701557, 
R7F701560, R7F701561, R7F701562, R7F701563, R7F701566, 
R7F701567, R7F701577, R7F701580, R7F701581, R7F701582, 
R7F701583, R7F701586, R7F701587, R7F701597, R7F701602, 
R7F701603, R7F701610, R7F701611, R7F701612, R7F701613, 
R7F701620, R7F701621, R7F701622, R7F701623,(Debug Support Only) 

F1KH R7F701708, R7F701709, R7F701710, R7F701711, R7F701714, 
R7F701715,(Debug Support Only) 

F1KM 
R7F701644, R7F701645, R7F701646, R7F701647, R7F701648, 
R7F701649, R7F701650, R7F701651, R7F701652, R7F701653, 
R7F701684, R7F701685, R7F701686, R7F701687, R7F701688, 
R7F701689, R7F701690, R7F701691, R7F701692, R7F701693, 
R7F701694, R7F701695,(Debug Support Only) 

F1L 

R7F701002xAFP, R7F701003xAFP, R7F701006xAFP, R7F701007xAFP, 
R7F701008xAFP, R7F701009xAFP, R7F701010xAFP, R7F701011xAFP, 
R7F701012xAFP, R7F701013xAFP, R7F701014xAFP, R7F701015xAFP, 
R7F701016xAFP, R7F701017xAFP, R7F701018xAFP, R7F701019xAFP, 
R7F701020xAFP, R7F701021xAFP, R7F701022xAFP, R7F701023xAFP, 
R7F701024xAFP, R7F701025xAFP, R7F701026xAFP, R7F701027xAFP, 
R7F701028xAFP, R7F701029xAFP, R7F701030xAFP, R7F701032xAFP, 
R7F701033xAFP, R7F701034xAFP, R7F701040, R7F701041, R7F701042, 
R7F701043, R7F701044, R7F701045, R7F701046, R7F701047, 
R7F701048, R7F701049, R7F701050, R7F701051, R7F701052, 
R7F701053, R7F701054, R7F701055, R7F701056, R7F701057,(Debug 
Support Only) 

F1M R7F701544, R7F701545, R7F701548, R7F701549, R7F701552, 
R7F701553, R7F701564, R7F701565, R7F701568, R7F701569, 
R7F701572, R7F701573,(Debug Support Only) 

P1H-C R7F701370AEEBG, R7F701371EABG, R7F701372EABG, 
R7F701396EABG,(Debug Support Only) 

P1L-C 
R7F701388, R7F701389, R7F701390, R7F701391,(Debug Support Only) 

P1M R7F701304, R7F701305, R7F701310, R7F701311, R7F701312, 
R7F701313, R7F701314, R7F701315, R7F701318, R7F701319, 
R7F701320, R7F701321, R7F701322, R7F701323,(Debug Support Only) 

P1M-C R7F701373xABG, R7F701374xAFP, R7F701397xABG,(Debug Support 
Only) 

P1M-E R7F701375, R7F701376, R7F701377, R7F701378, R7F701379, 
R7F701380, R7F701381, R7F701382, R7F701383, R7F701384, 
R7F701385, R7F701386,(Debug Support Only) 

- R7F701060xAFP, R7F701062xAFP, R7F701064xAFP, R7F701065xAFP, 
R7F701067xAFP, R7F701069xAFP, R7F701071xAFP,(Debug Support 
Only) 
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RL78 

D1A 
R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, 
R5F10CME, R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD, R5F10DLE, 
R5F10DMD, R5F10DME, R5F10DMF, R5F10DMG, R5F10DMJ, 
R5F10DPE, R5F10DPF, R5F10DPG, R5F10DPJ, R5F10DPK, R5F10DPL, 
R5F10DSJ, R5F10DSK, R5F10DSL, R5F10TPJ 

F12 
R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, R5F1096E, 
R5F109AA, R5F109AB, R5F109AC, R5F109AD, R5F109AE, R5F109BA, 
R5F109BB, R5F109BC, R5F109BD, R5F109BE, R5F109GA, R5F109GB, 
R5F109GC, R5F109GD, R5F109GE, R5F109LA, R5F109LB, R5F109LC, 
R5F109LD, R5F109LE 

F13 

R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, R5F10AAC, 
R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC, R5F10ABD, R5F10ABE, 
R5F10AGA, R5F10AGC, R5F10AGD, R5F10AGE, R5F10AGF, R5F10AGG, 
R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, 
R5F10AMF, R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, 
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, R5F10BBG, 
R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, R5F10BGG, R5F10BLC, 
R5F10BLD, R5F10BLE, R5F10BLF, R5F10BLG, R5F10BME, R5F10BMF, 
R5F10BMG 

F14 
R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGE, 
R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ, R5F10PLE, R5F10PLF, 
R5F10PLG, R5F10PLH, R5F10PLJ, R5F10PME, R5F10PMF, R5F10PMG, 
R5F10PMH, R5F10PMJ, R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH, 
R5F10PPJ 

F15 R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, R5F113ML, 
R5F113PG, R5F113PH, R5F113PJ, R5F113PK, R5F113PL, R5F113TG, 
R5F113TH, R5F113TJ, R5F113TK, R5F113TL 

F1A R5F114GC, R5F114GD, R5F114GE, R5F114GF, R5F114GG 
F1E R5F11KLE, R5F11KLF, R5F11KLG, R5F11LLE, R5F11LLF, R5F11LLG 
G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47 
G11 R5F1051A, R5F1054A, R5F1056A, R5F1057A, R5F1058A 

G12 
R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, R5F10277, 
R5F10278, R5F10279, R5F1027A, R5F102A7, R5F102A8, R5F102A9, 
R5F102AA, R5F10366, R5F10367, R5F10368, R5F10369, R5F1036A, 
R5F10377, R5F10378, R5F10379, R5F1037A, R5F103A7, R5F103A8, 
R5F103A9, R5F103AA 
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G13 

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C, 
R5F1007D, R5F1007E, R5F1008A, R5F1008C, R5F1008D, R5F1008E, 
R5F100AA, R5F100AC, R5F100AD, R5F100AE, R5F100AF, R5F100AG, 
R5F100BA, R5F100BC, R5F100BD, R5F100BE, R5F100BF, R5F100BG, 
R5F100CA, R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG, 
R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF, R5F100EG, 
R5F100EH, R5F100FA, R5F100FC, R5F100FD, R5F100FE, R5F100FF, 
R5F100FG, R5F100FH, R5F100FJ, R5F100FK, R5F100FL, R5F100GA, 
R5F100GC, R5F100GD, R5F100GE, R5F100GF, R5F100GG, R5F100GH, 
R5F100GJ, R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE, 
R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK, R5F100JL, 
R5F100LC, R5F100LD, R5F100LE, R5F100LF, R5F100LG, R5F100LH, 
R5F100LJ, R5F100LK, R5F100LL, R5F100MF, R5F100MG, R5F100MH, 
R5F100MJ, R5F100MK, R5F100ML, R5F100PF, R5F100PG, R5F100PH, 
R5F100PJ, R5F100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK, 
R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, R5F1017A, 
R5F1017C, R5F1017D, R5F1017E, R5F1018A, R5F1018C, R5F1018D, 
R5F1018E, R5F101AA, R5F101AC, R5F101AD, R5F101AE, R5F101AF, 
R5F101AG, R5F101BA, R5F101BC, R5F101BD, R5F101BE, R5F101BF, 
R5F101BG, R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF, 
R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE, R5F101EF, 
R5F101EG, R5F101EH, R5F101FA, R5F101FC, R5F101FD, R5F101FE, 
R5F101FF, R5F101FG, R5F101FH, R5F101FJ, R5F101FK, R5F101FL, 
R5F101GA, R5F101GC, R5F101GD, R5F101GE, R5F101GF, R5F101GG, 
R5F101GH, R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD, 
R5F101JE, R5F101JF, R5F101JG, R5F101JH, R5F101JJ, R5F101JK, 
R5F101JL, R5F101LC, R5F101LD, R5F101LE, R5F101LF, R5F101LG, 
R5F101LH, R5F101LJ, R5F101LK, R5F101LL, R5F101MF, R5F101MG, 
R5F101MH, R5F101MJ, R5F101MK, R5F101ML, R5F101PF, R5F101PG, 
R5F101PH, R5F101PJ, R5F101PK, R5F101PL, R5F101SH, R5F101SJ, 
R5F101SK, R5F101SL 

G13A R5F140FK, R5F140FL, R5F140GK, R5F140GL, R5F140LK, R5F140LL, 
R5F140PK, R5F140PL 

G14 

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, R5F104AG, 
R5F104BA, R5F104BC, R5F104BD, R5F104BE, R5F104BF, R5F104BG, 
R5F104CA, R5F104CC, R5F104CD, R5F104CE, R5F104CF, R5F104CG, 
R5F104EA, R5F104EC, R5F104ED, R5F104EE, R5F104EF, R5F104EG, 
R5F104EH, R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF, 
R5F104FG, R5F104FH, R5F104FJ, R5F104GA, R5F104GC, R5F104GD, 
R5F104GE, R5F104GF, R5F104GG, R5F104GH, R5F104GJ, R5F104GK, 
R5F104GL, R5F104JC, R5F104JD, R5F104JE, R5F104JF, R5F104JG, 
R5F104JH, R5F104JJ, R5F104LC, R5F104LD, R5F104LE, R5F104LF, 
R5F104LG, R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF, 
R5F104MG, R5F104MH, R5F104MJ, R5F104MK, R5F104ML, R5F104PF, 
R5F104PG, R5F104PH, R5F104PJ, R5F104PK, R5F104PL 

G1A R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, R5F10EBC, 
R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, R5F10EGD, R5F10EGE, 
R5F10ELC, R5F10ELD, R5F10ELE 

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC 
G1D R5F11AGG, R5F11AGH, R5F11AGJ 
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G1E R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, R5F10FME 

G1F R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, R5F11BCE, 
R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE 

G1G R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, R5F11EF8, R5F11EFA 
G1H R5F11FLJ, R5F11FLK, R5F11FLL 
G1K R5F11VBG, R5F11VLG 
G1M R5F11W67, R5F11W68 
G1N R5F11Y67, R5F11Y68 
G1P R5F11Z7A, R5F11ZBA 

H1D R5F11NGF, R5F11NGG, R5F11NLF, R5F11NLG, R5F11NME, R5F11NMF, 
R5F11NMG, R5F11PLF, R5F11PLG, R5F11RMG 

I1A R5F1076C, R5F107AC, R5F107AE, R5F107DE 
I1B R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG 

I1C R5F10NLE, R5F10NLG, R5F10NME, R5F10NMG, R5F10NMJ, R5F10NPG, 
R5F10NPJ 

I1C-2 R5F11TLE, R5F11TLG 

I1D R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, R5F117AA, 
R5F117AC, R5F117BA, R5F117BC, R5F117GA, R5F117GC 

I1E R5F11CBC, R5F11CCC 

L12 R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC, 
R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RJC, 
R5F10RLA, R5F10RLC 

L13 R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, 
R5F10WLG, R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, 
R5F10WMF, R5F10WMG 

L1A R5F11MMD, R5F11MME, R5F11MMF, R5F11MPE, R5F11MPF, 
R5F11MPG 

L1C R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, R5F110NE, 
R5F110NF, R5F110NG, R5F110NH, R5F110NJ, R5F110PE, R5F110PF, 
R5F110PG, R5F110PH, R5F110PJ, R5F111ME, R5F111MF, R5F111MG, 
R5F111MH, R5F111MJ, R5F111NE, R5F111NF, R5F111NG, R5F111NH, 
R5F111NJ, R5F111PE, R5F111PF, R5F111PG, R5F111PH, R5F111PJ 

RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, 
R5F51118, R5F5111J 

113 R5F51135, R5F51136, R5F51137, R5F51138 

130 R5F51303, R5F51305, R5F51305B, R5F51306, R5F51306B, R5F51307, 
R5F51308 

13T R5F513T3, R5F513T5 

210 R5F52103, R5F52104, R5F52105, R5F52106, R5F52107, R5F52108, 
R5F5210A, R5F5210B 

21A R5F521A6, R5F521A7, R5F521A8 
220 R5F52201, R5F52203, R5F52205, R5F52206 
230 R5F52305, R5F52306 
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231 R5F52315, R5F52316, R5F52317, R5F52318 
23E-A R5F523E5A, R5F523E5S, R5F523E6A, R5F523E6S 
23T R5F523T3, R5F523T5 
23W R5F523W7, R5F523W8 
24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE 
24U R5F524UB, R5F524UC, R5F524UE 
610 R5F56104, R5F56106, R5F56107, R5F56108 
621 R5F56216, R5F56217, R5F56218 
62G R5F562G7, R5F562GA 
62N R5F562N7, R5F562N8 
62T R5F562T6, R5F562T7, R5F562TA 
630 R5F56307, R5F56308, R5F5630A, R5F5630B, R5F5630D, R5F5630E 

631 
R5F56316, R5F56317, R5F56318, R5F5631A, R5F5631B, R5F5631D, 
R5F5631E, R5F5631F, R5F5631G, R5F5631J, R5F5631K, R5F5631M, 
R5F5631MF, R5F5631N, R5F5631P, R5F5631PF, R5F5631W, R5F5631Y, 
R5S56310 

634 R5F5634B, R5F5634B_5V, R5F5634D, R5F5634D_5V, R5F5634E, 
R5F5634E_5V 

63N R5F563NA, R5F563NB, R5F563ND, R5F563NE, R5F563NF, R5F563NK, 
R5F563NW, R5F563NY 

63T R5F563T4, R5F563T5, R5F563T6, R5F563TB, R5F563TB_5V, R5F563TC, 
R5F563TC_5V, R5F563TE, R5F563TE_5V 

64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 

651 
R5F56514, R5F56517, R5F56519, R5F5651C, R5F5651C_DUAL, 
R5F5651E, R5F5651E_DUAL 
 
R5F56519DMB, R5F5651EDMB, R5F5651EDMB_DUAL,(Debug Support 
Only) 

65N 
R5F565N4, R5F565N7, R5F565N9, R5F565NC, R5F565NC_DUAL, 
R5F565NE, R5F565NE_DUAL 
 
R5F565N9DMB, R5F565NEDMB, R5F565NEDMB_DUAL,(Debug Support 
Only) 

66N R5F566ND, R5F566ND_DUAL, R5F566NN, R5F566NN_DUAL 
66T R5F566TA, R5F566TE, R5F566TF, R5F566TK 
71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML 
72M R5F572MD, R5F572MD_DUAL, R5F572MN, R5F572MN_DUAL 
72N R5F572ND, R5F572ND_DUAL, R5F572NN, R5F572NN_DUAL 
72T R5F572TF, R5F572TK 

- R0E5571MLDMBXX,(Debug Support Only) 

RZ A1 
R7S721000, R7S721000_DualSPI, R7S721001, R7S721001_DualSPI, 
R7S721010, R7S721010_DualSPI, R7S721011, R7S721011_DualSPI, 
R7S721020, R7S721020_DualSPI, R7S721021, R7S721021_DualSPI, 
R7S721030, R7S721030_DualSPI, R7S721031, R7S721031_DualSPI, 
R7S721034, R7S721034_DualSPI 
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A2 R7S921040, R7S921041, R7S921042, R7S921043, R7S921045, 
R7S921046, R7S921047, R7S921048, R7S921051, R7S921052, 
R7S921053, R7S921056, R7S921057, R7S921058 

G1E R8A77450, R8A77450_Core1,(Debug Support Only) 
G1M R8A77430, R8A77430_Core1,(Debug Support Only) 

T1 

R7S910001, R7S910002, R7S910006, R7S910007, R7S910011, 
R7S910013, R7S910015, R7S910015_M3, R7S910016, R7S910016_M3, 
R7S910017, R7S910017_M3, R7S910018, R7S910018_M3, R7S910025, 
R7S910026, R7S910027, R7S910028, R7S910035, R7S910036, 
R7S910101, R7S910102, R7S910106, R7S910107, R7S910111, 
R7S910113, R7S910115, R7S910115_M3, R7S910116, R7S910116_M3, 
R7S910117, R7S910117_M3, R7S910118, R7S910118_M3, R7S910125, 
R7S910126, R7S910127, R7S910128, R7S910135, R7S910136 

T1-M R7S910020, R7S910021, R7S910022, R7S910023, R7S910120, 
R7S910121, R7S910122, R7S910123 

Synergy 

S1JA R7FS1JA783A01CFM, R7FS1JA783A01CNE, R7FS1JA783A01CNF, 
R7FS1JA782A01CBT, R7FS1JA783A01CFJ 

S124 
R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM, 
R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM, 
R7FS124773A01CNB, R7FS124773A01CNE, R7FS124773A01CNF 

S128 R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL, 
R7FS128783A01CFM, R7FS128783A01CNE, R7FS128783A01CNG 

S3A1 
R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CBJ, 
R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM, 
R7FS3A17C3A01CFP, R7FS3A17C3A01CNB 

S3A3 
R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CBJ, 
R7FS3A37A2A01CLJ, R7FS3A37A3A01CFP, R7FS3A37A3A01CFM, 
R7FS3A37A3A01CNB 

S3A6 
R7FS3A6782A01CLJ, R7FS3A6783A01CFL, R7FS3A6783A01CFM, 
R7FS3A6783A01CFP, R7FS3A6783A01CNB, R7FS3A6783A01CNE, 
R7FS3A6783A01CNF 

S3A7 
R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ, 
R7FS3A77C3A01CFP, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFM, 
R7FS3A77C2A01CNB, R7FS3A77C3A01CNB 

S5D3 R7FS5D37A2A01CLJ, R7FS5D37A3A01CFP, R7FS5D37A3A01CFM, 
R7FS5D37A3A01CNB 

S5D5 R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP, 
R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP 

S5D9 

R7FS5D97C2A01CBG, R7FS5D97C3A01CFC, R7FS5D97C2A01CLK, 
R7FS5D97C3A01CFB, R7FS5D97C3A01CFP, 
R7FS5D97E2A01CBG, R7FS5D97E3A01CFC, R7FS5D97E2A01CLK, 
R7FS5D97E3A01CFB, R7FS5D97E3A01CFP 

S7G2 

R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, R7FS7G27H2A01CBG, 
R7FS7G27G2A01CBG, R7FS7G27H2A01CFC, R7FS7G27H3A01CFC, 
R7FS7G27G2A01CFC, R7FS7G27G3A01CFC, R7FS7G27H2A01CLK, 
R7FS7G27G2A01CLK, R7FS7G27H3A01CFB, R7FS7G27G3A01CFB, 
R7FS7G27G3A01CFP 
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2.2 Code Generator Support – Windows Host 
 

Family Group Devices 

RL78 

D1A 

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, 
R5F10CME, R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD, 
R5F10DLE, R5F10DMD, R5F10DME, R5F10DMF, R5F10DMG, 
R5F10DMJ, R5F10DPE, R5F10DPF, R5F10DPG, R5F10DPJ, 
R5F10TPJ 

F12 

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, 
R5F1096E, R5F109AA, R5F109AB, R5F109AC, R5F109AD, 
R5F109AE, R5F109BA, R5F109BB, R5F109BC, R5F109BD, 
R5F109BE, R5F109GA, R5F109GB, R5F109GC, R5F109GD, 
R5F109GE, R5F109LA, R5F109LB, R5F109LC, R5F109LD, 
R5F109LE 

F13 

R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, 
R5F10AAC, R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC, 
R5F10ABD, R5F10ABE, R5F10AGA, R5F10AGC, R5F10AGD, 
R5F10AGE, R5F10AGF, R5F10AGG, R5F10ALC, R5F10ALD, 
R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, R5F10AMF, 
R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, 
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, 
R5F10BBG, R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, 
R5F10BGG, R5F10BLC, R5F10BLD, R5F10BLE, R5F10BLF, 
R5F10BLG, R5F10BME, R5F10BMF, R5F10BMG 

F14 
R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, 
R5F10PGE, R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ, 
R5F10PLE, R5F10PLF, R5F10PLG, R5F10PLH, R5F10PLJ, 
R5F10PME, R5F10PMF, R5F10PMG, R5F10PMH, R5F10PMJ, 
R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH, R5F10PPJ 

F15 

R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, 
R5F113ML, R5F113PG, R5F113PH, R5F113PJ, R5F113PK, 
R5F113PL, R5F113TG, R5F113TH, R5F113TJ, R5F113TK, 
R5F113TL 

F1E R5F11KLE, R5F11KLF, R5F11KLG, R5F11LLE, R5F11LLF, 
R5F11LLG 

G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, 
R5F10Y47 

G11 R5F1051A, R5F1054A, R5F1056A, R5F1057A, R5F1058A 

G12 

R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, 
R5F10277, R5F10278, R5F10279, R5F1027A, R5F102A7, 
R5F102A8, R5F102A9, R5F102AA, R5F10366, R5F10367, 
R5F10368, R5F10369, R5F1036A, R5F10377, R5F10378, 
R5F10379, R5F1037A, R5F103A7, R5F103A8, R5F103A9, 
R5F103AA 
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G13 

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, 
R5F1007C, R5F1007D, R5F1007E, R5F1008A, R5F1008C, 
R5F1008D, R5F1008E, R5F100AA, R5F100AC, R5F100AD, 
R5F100AE, R5F100AF, R5F100AG, R5F100BA, R5F100BC, 
R5F100BD, R5F100BE, R5F100BF, R5F100BG, R5F100CA, 
R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG, 
R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF, 
R5F100EG, R5F100EH, R5F100FA, R5F100FC, R5F100FD, 
R5F100FE, R5F100FF, R5F100FG, R5F100FH, R5F100FJ, 
R5F100FK, R5F100FL, R5F100GA, R5F100GC, R5F100GD, 
R5F100GE, R5F100GF, R5F100GG, R5F100GH, R5F100GJ, 
R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE, 
R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK, 
R5F100JL, R5F100LC, R5F100LD, R5F100LE, R5F100LF, 
R5F100LG, R5F100LH, R5F100LJ, R5F100LK, R5F100LL, 
R5F100MF, R5F100MG, R5F100MH, R5F100MJ, R5F100MK, 
R5F100ML, R5F100PF, R5F100PG, R5F100PH, R5F100PJ, 
R5F100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK, 
R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, 
R5F1017A, R5F1017C, R5F1017D, R5F1017E, R5F1018A, 
R5F1018C, R5F1018D, R5F1018E, R5F101AA, R5F101AC, 
R5F101AD, R5F101AE, R5F101AF, R5F101AG, R5F101BA, 
R5F101BC, R5F101BD, R5F101BE, R5F101BF, R5F101BG, 
R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF, 
R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE, 
R5F101EF, R5F101EG, R5F101EH, R5F101FA, R5F101FC, 
R5F101FD, R5F101FE, R5F101FF, R5F101FG, R5F101FH, 
R5F101FJ, R5F101FK, R5F101FL, R5F101GA, R5F101GC, 
R5F101GD, R5F101GE, R5F101GF, R5F101GG, R5F101GH, 
R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD, 
R5F101JE, R5F101JF, R5F101JG, R5F101JH, R5F101JJ, 
R5F101JK, R5F101JL, R5F101LC, R5F101LD, R5F101LE, 
R5F101LF, R5F101LG, R5F101LH, R5F101LJ, R5F101LK, 
R5F101LL, R5F101MF, R5F101MG, R5F101MH, R5F101MJ, 
R5F101MK, R5F101ML, R5F101PF, R5F101PG, R5F101PH, 
R5F101PJ, R5F101PK, R5F101PL, R5F101SH, R5F101SJ, 
R5F101SK, R5F101SL 

G13A R5F140FK, R5F140FL, R5F140GK, R5F140GL, R5F140LK, 
R5F140LL, R5F140PK, R5F140PL 

G14 

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, 
R5F104AG, R5F104BA, R5F104BC, R5F104BD, R5F104BE, 
R5F104BF, R5F104BG, R5F104CA, R5F104CC, R5F104CD, 
R5F104CE, R5F104CF, R5F104CG, R5F104EA, R5F104EC, 
R5F104ED, R5F104EE, R5F104EF, R5F104EG, R5F104EH, 
R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF, 
R5F104FG, R5F104FH, R5F104FJ, R5F104GA, R5F104GC, 
R5F104GD, R5F104GE, R5F104GF, R5F104GG, R5F104GH, 
R5F104GJ, R5F104GK, R5F104GL, R5F104JC, R5F104JD, 
R5F104JE, R5F104JF, R5F104JG, R5F104JH, R5F104JJ, 
R5F104LC, R5F104LD, R5F104LE, R5F104LF, R5F104LG, 
R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF, 
R5F104MG, R5F104MH, R5F104MJ, R5F104MK, R5F104ML, 
R5F104PF, R5F104PG, R5F104PH, R5F104PJ, R5F104PK, 
R5F104PL 

G1A R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, 
R5F10EBC, R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, 
R5F10EGD, R5F10EGE, R5F10ELC, R5F10ELD, R5F10ELE 

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC 
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G1D R5F11AGG, R5F11AGH, R5F11AGJ 

G1E R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, 
R5F10FME 

G1F R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, 
R5F11BCE, R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE 

G1G R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, R5F11EF8, 
R5F11EFA 

G1H R5F11FLJ, R5F11FLK, R5F11FLL 

H1D R5F11NGF, R5F11NGG, R5F11NLF, R5F11NLG, R5F11NME, 
R5F11NMF, R5F11NMG, R5F11PLF, R5F11PLG, R5F11RMG 

I1A R5F1076C, R5F107AC, R5F107AE, R5F107DE 
I1B R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG 

I1C R5F10NLE, R5F10NLG, R5F10NME, R5F10NMG, R5F10NMJ, 
R5F10NPJ 

I1C-2 R5F11TLE, R5F11TLG 

I1D 
R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, 
R5F117AA, R5F117AC, R5F117BA, R5F117BC, R5F117GA, 
R5F117GC 

I1E R5F11CBC, R5F11CCC 

L12 R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, 
R5F10RFC, R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJ8, 
R5F10RJA, R5F10RJC, R5F10RLA, R5F10RLC 

L13 R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, 
R5F10WLG, R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, 
R5F10WMF, R5F10WMG 

L1A R5F11MMD, R5F11MME, R5F11MMF, R5F11MPE, R5F11MPF, 
R5F11MPG 

L1C 
R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, 
R5F110PE, R5F110PF, R5F110PG, R5F110PH, R5F110PJ, 
R5F111ME, R5F111MF, R5F111MG, R5F111MH, R5F111MJ, 
R5F111PE, R5F111PF, R5F111PG, R5F111PH, R5F111PJ 

RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, 
R5F51117, R5F51118, R5F5111J 

113 R5F51135, R5F51136, R5F51137, R5F51138 
130 R5F51303, R5F51305 
230 R5F52305, R5F52306 
231 R5F52315, R5F52316, R5F52317, R5F52318 
23T R5F523T3, R5F523T5 
24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE 
24U R5F524UB, R5F524UC, R5F524UE 
64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 
651 R5F56514, R5F56517, R5F56519 
65N R5F565N4, R5F565N7, R5F565N9 
71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML 
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RZ T1 

R7S910001, R7S910002, R7S910006, R7S910007, R7S910011, 
R7S910013, R7S910015, R7S910016, R7S910017, R7S910018, 
R7S910025, R7S910026, R7S910027, R7S910028, R7S910035, 
R7S910036, R7S910101, R7S910102, R7S910106, R7S910107, 
R7S910111, R7S910113, R7S910115, R7S910116, R7S910117, 
R7S910118, R7S910125, R7S910126, R7S910127, R7S910128, 
R7S910135, R7S910136 
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2.3 Smart Configurator Support – Windows Host 
 

Family Group Devices 

RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, R5F51118, 
R5F5111J 

113 R5F51135, R5F51136, R5F51137, R5F51138 

130 R5F51303, R5F51305, R5F51305B, R5F51306, R5F51306B, R5F51307, 
R5F51308 

13T R5F513T3, R5F513T5 
230 R5F52305, R5F52306 
231 R5F52315, R5F52316, R5F52317, R5F52318 

23E-A R5F523E5A, R5F523E5S, R5F523E6A, R5F523E6S 
23T R5F523T3, R5F523T5 
23W R5F523W7, R5F523W8 
24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE 
24U R5F524UB, R5F524UC, R5F524UE 
64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 

651 R5F56514, R5F56517, R5F56519, R5F5651C, R5F5651C_DUAL, R5F5651E, 
R5F5651E_DUAL 

65N R5F565N4, R5F565N7, R5F565N9, R5F565NC, R5F565NC_DUAL, R5F565NE, 
R5F565NE_DUAL 

66N R5F566ND, R5F566ND_DUAL, R5F566NN, R5F566NN_DUAL 
66T R5F566TA, R5F566TE, R5F566TF, R5F566TK 
71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML 
72M R5F572MD, R5F572MD_DUAL, R5F572MN, R5F572MN_DUAL 
72N R5F572ND, R5F572ND_DUAL, R5F572NN, R5F572NN_DUAL 
72T R5F572TF, R5F572TK 

Synergy 

S1JA R7FS1JA783A01CFM, R7FS1JA783A01CNE, R7FS1JA783A01CNF, 
R7FS1JA782A01CBT, R7FS1JA783A01CFJ 

S124 
R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM, 
R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM, 
R7FS124773A01CNB, R7FS124773A01CNE, R7FS124773A01CNF 

S128 R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL, 
R7FS128783A01CFM, R7FS128783A01CNE, R7FS128783A01CNG 

S3A1 
R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CBJ, 
R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM, 
R7FS3A17C3A01CFP, R7FS3A17C3A01CNB 

S3A3 
R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CBJ, 
R7FS3A37A2A01CLJ, R7FS3A37A3A01CFP, R7FS3A37A3A01CFM, 
R7FS3A37A3A01CNB 

S3A6 
R7FS3A6782A01CLJ, R7FS3A6783A01CFL, R7FS3A6783A01CFM, 
R7FS3A6783A01CFP, R7FS3A6783A01CNB, R7FS3A6783A01CNE, 
R7FS3A6783A01CNF 

S3A7 
R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ, 
R7FS3A77C3A01CFP, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFM, 
R7FS3A77C2A01CNB, R7FS3A77C3A01CNB 
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S5D3 R7FS5D37A2A01CLJ, R7FS5D37A3A01CFP, R7FS5D37A3A01CFM, 
R7FS5D37A3A01CNB 

S5D5 R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP, 
R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP 

S5D9 

R7FS5D97C2A01CBG, R7FS5D97C3A01CFC, R7FS5D97C2A01CLK, 
R7FS5D97C3A01CFB, R7FS5D97C3A01CFP, 
R7FS5D97E2A01CBG, R7FS5D97E3A01CFC, R7FS5D97E2A01CLK, 
R7FS5D97E3A01CFB, R7FS5D97E3A01CFP 

S7G2 

R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, R7FS7G27H2A01CBG, 
R7FS7G27G2A01CBG, R7FS7G27H2A01CFC, R7FS7G27H3A01CFC, 
R7FS7G27G2A01CFC, R7FS7G27G3A01CFC, R7FS7G27H2A01CLK, 
R7FS7G27G2A01CLK, R7FS7G27H3A01CFB, R7FS7G27G3A01CFB, 
R7FS7G27G3A01CFP 

RA 

RA2A1 R7FA2A1AB2CBT, R7FA2A1AB3CFJ, R7FA2A1AB3CFM, R7FA2A1AB3CNE, 
R7FA2A1AB3CNF 

RA4M1 R7FA4M1AB2CLJ, R7FA4M1AB3CFL, R7FA4M1AB3CFM, R7FA4M1AB3CFP, 
R7FA4M1AB3CNB, R7FA4M1AB3CNE, R7FA4M1AB3CNF 

RA6M1 R7FA6M1AD2CLJ, R7FA6M1AD3CFM, R7FA6M1AD3CFP, R7FA6M1AD3CNB 

RA6M2 R7FA6M2AD2CLK, R7FA6M2AD3CFB, R7FA6M2AD3CFP, R7FA6M2AF2CLK, 
R7FA6M2AF3CFB, R7FA6M2AF3CFP 

RA6M3 
R7FA6M3AF2CBG, R7FA6M3AF2CLK, R7FA6M3AF3CFB, R7FA6M3AF3CFC, 
R7FA6M3AF3CFP, R7FA6M3AH2CBG, R7FA6M3AH2CLK, R7FA6M3AH3CFB, 
R7FA6M3AH3CFC, R7FA6M3AH3CFP 

RA6M4 
R7FA6M4AF3CFB, R7FA6M4AF3CFP, R7FA6M4AF3CFM, R7FA6M4AE3CFB, 
R7FA6M4AE3CFP, R7FA6M4AE3CFM, R7FA6M4AD3CFB, R7FA6M4AD3CFP, 
R7FA6M4AD3CFM 

RA4W1 R7FA4W1AD2CNG 
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2.4 Project Generator Support – Linux Hosted 
Note: The Renesas SH device family is no longer supported in e2 studio. 

 

Family Group Devices 

RA 

RA2A1 R7FA2A1AB2CBT, R7FA2A1AB3CFJ, R7FA2A1AB3CFM, 
R7FA2A1AB3CNE, R7FA2A1AB3CNF 

RA4M1 
R7FA4M1AB2CLJ, R7FA4M1AB3CFL, R7FA4M1AB3CFM, 
R7FA4M1AB3CFP, R7FA4M1AB3CNB, R7FA4M1AB3CNE, 
R7FA4M1AB3CNF 

RA6M1 R7FA6M1AD2CLJ, R7FA6M1AD3CFM, R7FA6M1AD3CFP, 
R7FA6M1AD3CNB 

RA6M2 R7FA6M2AD2CLK, R7FA6M2AD3CFB, R7FA6M2AD3CFP, 
R7FA6M2AF2CLK, R7FA6M2AF3CFB, R7FA6M2AF3CFP 

RA6M3 

R7FA6M3AF2CBG, R7FA6M3AF2CLK, R7FA6M3AF3CFB, 
R7FA6M3AF3CFC, R7FA6M3AF3CFP, R7FA6M3AH2CBG, 
R7FA6M3AH2CLK, R7FA6M3AH3CFB, R7FA6M3AH3CFC, 
R7FA6M3AH3CFP 

RA4W1 R7FA4W1AD2CNG 

RZ 

A1 
R7S721000, R7S721000_DualSPI, R7S721001, R7S721001_DualSPI, 
R7S721010, R7S721010_DualSPI, R7S721011, R7S721011_DualSPI, 
R7S721020, R7S721020_DualSPI, R7S721021, R7S721021_DualSPI, 
R7S721030, R7S721030_DualSPI, R7S721031, R7S721031_DualSPI, 
R7S721034, R7S721034_DualSPI 

A2 R7S921040, R7S921041, R7S921042, R7S921043, R7S921045, 
R7S921046, R7S921047, R7S921048, R7S921051, R7S921052, 
R7S921053, R7S921056, R7S921057, R7S921058 

G1E R8A77450, R8A77450_Core1,(Debug Support Only) 
G1M R8A77430, R8A77430_Core1,(Debug Support Only) 

T1 

R7S910001, R7S910002, R7S910006, R7S910007, R7S910011, 
R7S910013, R7S910015, R7S910015_M3, R7S910016, R7S910016_M3, 
R7S910017, R7S910017_M3, R7S910018, R7S910018_M3, R7S910025, 
R7S910026, R7S910027, R7S910028, R7S910035, R7S910036, 
R7S910101, R7S910102, R7S910106, R7S910107, R7S910111, 
R7S910113, R7S910115, R7S910115_M3, R7S910116, R7S910116_M3, 
R7S910117, R7S910117_M3, R7S910118, R7S910118_M3, R7S910125, 
R7S910126, R7S910127, R7S910128, R7S910135, R7S910136 

T1-M R7S910020, R7S910021, R7S910022, R7S910023, R7S910120, 
R7S910121, R7S910122, R7S910123 

Synergy 

S1JA R7FS1JA783A01CFM, R7FS1JA783A01CNE, R7FS1JA783A01CNF, 
R7FS1JA782A01CBT, R7FS1JA783A01CFJ 

S124 
R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM, 
R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM, 
R7FS124773A01CNB, R7FS124773A01CNE, R7FS124773A01CNF 

S128 R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL, 
R7FS128783A01CFM, R7FS128783A01CNE, R7FS128783A01CNG 

S3A1 
R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CBJ, 
R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM, 
R7FS3A17C3A01CFP, R7FS3A17C3A01CNB 
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S3A3 
R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CBJ, 
R7FS3A37A2A01CLJ, R7FS3A37A3A01CFP, R7FS3A37A3A01CFM, 
R7FS3A37A3A01CNB 

S3A6 
R7FS3A6782A01CLJ, R7FS3A6783A01CFL, R7FS3A6783A01CFM, 
R7FS3A6783A01CFP, R7FS3A6783A01CNB, R7FS3A6783A01CNE, 
R7FS3A6783A01CNF 

S3A7 
R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ, 
R7FS3A77C3A01CFP, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFM, 
R7FS3A77C2A01CNB, R7FS3A77C3A01CNB 

S5D3 R7FS5D37A2A01CLJ, R7FS5D37A3A01CFP, R7FS5D37A3A01CFM, 
R7FS5D37A3A01CNB 

S5D5 R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP, 
R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP 

S5D9 

R7FS5D97C2A01CBG, R7FS5D97C3A01CFC, R7FS5D97C2A01CLK, 
R7FS5D97C3A01CFB, R7FS5D97C3A01CFP, 
R7FS5D97E2A01CBG, R7FS5D97E3A01CFC, R7FS5D97E2A01CLK, 
R7FS5D97E3A01CFB, R7FS5D97E3A01CFP 

S7G2 

R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, R7FS7G27H2A01CBG, 
R7FS7G27G2A01CBG, R7FS7G27H2A01CFC, R7FS7G27H3A01CFC, 
R7FS7G27G2A01CFC, R7FS7G27G3A01CFC, R7FS7G27H2A01CLK, 
R7FS7G27G2A01CLK, R7FS7G27H3A01CFB, R7FS7G27G3A01CFB, 
R7FS7G27G3A01CFP 
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2.5 Smart Configurator Support – Linux Host 
 

Family Group Devices 

RA 

RA2A1 R7FA2A1AB2CBT, R7FA2A1AB3CFJ, R7FA2A1AB3CFM, R7FA2A1AB3CNE, 
R7FA2A1AB3CNF 

RA4M1 R7FA4M1AB2CLJ, R7FA4M1AB3CFL, R7FA4M1AB3CFM, R7FA4M1AB3CFP, 
R7FA4M1AB3CNB, R7FA4M1AB3CNE, R7FA4M1AB3CNF 

RA6M1 R7FA6M1AD2CLJ, R7FA6M1AD3CFM, R7FA6M1AD3CFP, R7FA6M1AD3CNB 

RA6M2 R7FA6M2AD2CLK, R7FA6M2AD3CFB, R7FA6M2AD3CFP, R7FA6M2AF2CLK, 
R7FA6M2AF3CFB, R7FA6M2AF3CFP 

RA6M3 
R7FA6M3AF2CBG, R7FA6M3AF2CLK, R7FA6M3AF3CFB, R7FA6M3AF3CFC, 
R7FA6M3AF3CFP, R7FA6M3AH2CBG, R7FA6M3AH2CLK, R7FA6M3AH3CFB, 
R7FA6M3AH3CFC, R7FA6M3AH3CFP 

RA6M4 
R7FA6M4AF3CFB, R7FA6M4AF3CFP, R7FA6M4AF3CFM, R7FA6M4AE3CFB, 
R7FA6M4AE3CFP, R7FA6M4AE3CFM, R7FA6M4AD3CFB, R7FA6M4AD3CFP, 
R7FA6M4AD3CFM 

RA4W1 R7FA4W1AD2CNG 
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3. Smart Manual Support 
Smart manual support is delivered independently of e² studio releases when available. The following devices are 
available as of October 2020: 

• RX110 

• RX111 

• RX113  

• RX130 

• RX210 

• RX220  

• RX230  

• RX231 

• RX23E-A 

• RX24U 

• RX24T 

• RX62G 

• RX62T 

• RX631 

• RX63N 

• RX63T 

• RX651 

• RX64M 

• RX65N 

• RX66T 

• RX71M 

• RX72M 

• RX72T 

• RL78/G10 

• RL78/G11 

• RL78/G12 

• RL78/G13 

• RL78/G14 

• RL78/G1F 

• RL78/L12 

• RL78/L13 

• RZ/A1H  

• RZ/A1L  

• RZ/A2M 

• RZ/T1 
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4. What is new in 2020-10? 
 

Component Device Description 

Application All 

2020-10 is based on the updated Eclipse Platform 2020-09 & CDT 
9.11 which includes new features & performance improvements. 

Various changes have been made which can be viewed in the link 
below: 

https://wiki.eclipse.org/CDT/User/NewIn911 

 

RA Project 
Generation and 
Smart Configurator 

RA 

The RA project generator has been updated to support the different 
project types for TrustZone support. 

 

You can now create Flat (Non-TrustZone), TrustZone Secure Project 
(allowing execution in the secure area of the device) and TrustZone 
Non-secure Project (allowing execution in the non-secure area of the 
device) 

RA Smart 
Configurator RA 

When configuring a TrustZone Secure Project in the RA it is possible 
to expose secure components to the Non-Secure project. 

This is possible by right-clicking on the module in the “Stacks 
Configuration” and selecting “Non-secure Callable” on the pop-up 
menu. 

https://wiki.eclipse.org/CDT/User/NewIn911
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RA Debugging RA 

ARM TrustZone technology provides a system-wide approach to 
security with hardware-enforced isolation integrated into the CPU. 

e2 studio now provides debugging features for both secure and non-
secure applications on Renesas devices with ARM TrustZone. 

e2 studio automatically creates Debug Configurations for your secure 
and non-secure TrustZone projects. 

e2 studio automatically programs the memory boundaries to separate 
the memory regions according to the TrustZone projects configuration 
when a debugging connection is initiated.  

This feature brings convenience as you do not have to manually 
program the memory boundaries each time the size of the secure 
program changes. 
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RA Debugging RA 

Renesas Device Partition Manager is a tool embedded into e2 studio 
to assist debugging TrustZone projects by providing TrustZone related 
features, e.g.: DLM state transitioning, secure/non-secure memory 
boundaries setting, device initialization and current device status 
retrieval. 

The purpose of Renesas Device Partition Manager is to provide only 
the basic and essential TrustZone related features embedded within 
e2 studio to ease the process of TrustZone debugging. 

 

 

FreeRTOS 
Configurator RX, RZ 

When creating new FreeRTOS (with IoT libraries) project, the tool will 
check current selected board and device, and inform user if current 
downloaded RTOS package does not support selected board and 
device. 
 
In case selected board is supported, the tool will create project with 
appropriate source files and settings for that board. 
 
There is an improvement on Renesas GitHub FreeRTOS Import 
feature. Filter text box is added to quickly filter project by inputting any 
information e.g. board, compiler, application type etc. 
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Smart Configurator RX 

The RX Smart Configurator has been enhanced in numerous 
areas: 

1. RX13T QFN packages are supported 
• R5F513T5AxNE 
• R5F513T5AxNF 

2. RX23E-A 1 Unit DSAD packages are supported 
• R5F523E5SxFL 
• R5F523E6SxFL 
• R5F523E5SxNF 
• R5F523E6SxNF 

3. New features 
• Improved performance at initial loading of the Smart 

Configurator tool and during the device change 
operation. 

• The component name (e.g. SCI(SCIF) Clock 
synchronous mode) is now displayed in the 
configuration panel when added to the Component 
page.  
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IO Registers RX 

In IO Register view, description for bit will show according to its value 
if Smart Manual database was installed and description for the bit 
value was included. 

 

RH850 Debugging RH850 

With the new support for G4 core devices, the ID authentication 
setting items for G4 core devices have been added. 

 

RH850 Debugging RH850 
 
The Work RAM address specification item has been added as a 
debug option for the RH850. 

RH850 Debugging RH850 

 
Devices of the RH850 family with E2 emulator support debugging 
instructions (DBCP, DBTAG, DBPUSH) for the output of software 
trace data to LPD. 
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This function helps the user to embed debugging instructions in the 
program to be executed as checkpoints or for the purpose of the 
output of specific information or register values and output of the 
history execution to the emulator side as trace data. 

 
 
 
The settings for software trace output to LPD can be selected on 
Acquisition dialog. 

 
 
Use "get_lpd_sfttrc" monitor command on Debugger Console view to 
get software trace and output to Console view. 
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To output the software trace result to an external file, enter the file 
path in command. Enter "True" or "False" to append data to file or not. 
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5. Useful workarounds and information for 2020-10 
Please visit the Renesas FAQ for e² studio for the latest up to date information: 

Online FAQ link. 

ID Component Workaround or information 
 Application When using the check for updates feature within e2 studio and updating from 

7.0.x to 7.1.x the initial restart after the update fails. An error message is 
displayed. Subsequent launches of e2 studio work without issue.  
 
This is caused by the update to Java. 
 

 SH support The Renesas SH device family is no longer supported in e2 studio. 
 
If you need to use the SH device support, please use e2 studio 5.4 or earlier. 
 

 Importing old 
projects into 
6.x 

All projects being migrated into the latest e2 studio from e2 studio 5.4 and earlier 
versions will need to be migrated to the new builder plugins. The new builder 
plugins have different user interface pages and different option IDs. 
 
Upon opening an older workspace, the following dialog would be displayed: 
 

Clicking OK will update the workspace to the newer e2 studio. 
 
Importing an existing project to the workspace or opening a workspace with old 
projects will automatically start the legacy project upgrade procedure.  
 
If for some reason this process does not start it is also possible to launch the 
“Upgrade Legacy of e2 studio Projects…” from the project context menu. 
 

 
 

https://en-support.renesas.com/knowledgeBase/category/30528/subcategory/30539
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The automatic system pops up a message bubble in the bottom left of the e2 
studio application window. 
 

 
 
After selecting the menu item or clicking the bubble the following dialog will be 
shown: 
 

 
 
To upgrade the project, click the corresponding check box and then click Finish. 
Note, this will update the project to the latest build plugins and options. Before 
doing this, you should ensure your project is backed up as this operation is not 
reversible. 
 
It is possible to upgrade multiple projects in a single operation. 
 
For the GCC toolchains for RX, RL and GNUARM-NONE have been made to 
the build options which mean we cannot guarantee the same binary output after 
upgrade. Please consider this before upgrading. 
 
Another consideration for migration is that debug configurations when opened in 
6.0 will also need to be migrated. The following message will be displayed. 
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Please ensure that your projects are backed up or in revision control before 
migration allowing you to return to older versions if required. 
 

 
 

Toolchain 
Management 
 

Before e2 studio 6.0 the toolchain management facility automatically upgraded or 
downgraded the imported project to the latest tools installed on the host 
machine. 
 
This no longer happens in the latest e2 studio. Instead the toolchain remains the 
same and user operation is the only way to change the toolchain version. 
 
This operation is now available within the build settings on the toolchain tab. An 
example of CCRX is shown below: 

 
If the particular toolchain version does not exist and build is performed, then an 
error message is displayed, and the build will fail. 

 RZ Toolchain The now legacy KPIT GNU ARM-NONE toolchain is still supported within the e2 
studio product but now using the gnuarmeclipse plugins. 
 
In addition RZ within e2 studio now supports the GNU ARM Launchpad 
toolchain. Available from https://launchpad.net/gcc-arm-embedded. 
 
One drawback of this toolchain is that it does not have a standard library builder 
provided in the same manner as the legacy KPIT ARM-NONE toolchain. To use 
this feature for ARM Launchpad and gain access to the more efficient optlib 
libraries a further download is required. 
 
This can be downloaded within the e2 studio installer or directly from here: 
https://gcc-renesas.com/rz/rz-download-toolchains/ 
 
Once integrated it is possible to integrate the library generator from the toolchain 
tab of the build settings page. 
 

https://launchpad.net/gcc-arm-embedded
https://gcc-renesas.com/rz/rz-download-toolchains/
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See “Create Library generator” option. Once checked the library generator 
(libgen) is added to the available tool settings. 
 

 QE 
compatibility 

If QE for TCP/IP V1.0.0 is used, please update it to V1.0.1. 
Other QE series can be used with e2 studio 6.0. 
 
What is QE? 
https://www.renesas.com/qe 
 
Details of QE for TCP/IP 
https://www.renesas.com/qe-tcpip  
 

5954 Application If you experience the error message “org.eclipse.swt.SWTError: No more 
handles” this can be caused by certain multi-monitor software and the Eclipse 
framework. 
 
If this error occurs there are 2 workarounds: 

1. Use a single monitor display. 
2. Uninstall the multiple monitor software from your graphics chipset 

vendor and revert to the standard Windows multi-monitor feature. 
 

6981 RL78 
Debugging 

When debugging IAR C source file with an OCD emulator (E1), the Monitor 
program area (0x00002-0x00003) is used. 

Therefore, this area must be excluded from usable address space.  
Please add '-HFF' in the linker option. 
1. Open Property. 
2. Select [C/C++ build]-[Settings] at left side. 
3. Select 'IAR RL78 Xlink linker' at right side, add '-HFF' at the textbox 

'command'. 
Not doing this will cause problems with connection and download when using 
interrupts. 

NA Application If you are experiencing slow building of projects within e² studio there are some 
possibilities to improve. 
The system environment will attempt to find the make.exe tool via the system 
environment.  If you ensure the directory, make resides in is at the start of the 
path variable it will find it more quickly.  Especially important if there are network 
drives in the path. 

https://www.renesas.com/qe
https://www.renesas.com/qe-tcpip
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In the project properties, C/C++ Build tab, behavior tab you can switch on 
parallel build.  This will take advantage of the multi-cores on your host machine if 
it has them. 
 

NA RZ GCC In 3.0 the KPIT GCC RZ toolchain was supported at version 14.01.  This version 
is no longer supported within e² studio. 
 
KPIT modified the name of their ARM toolchain to be ARM-none-eabi to follow 
standard ARM naming convention like other GCC toolchain vendors. 
 
The ARM-none toolchain is available at versions 14.01, 14.02 and 16.01 from 
the www.gcc-renesas.com website.  The binaries in the 14.01 version are 
identical to those used in the 14.01 RZ toolchain. 
 
Once the toolchain is installed your projects will be imported and ported to 
ensure there is as little disruption as possible due to this change. 
 

NA KPIT GCC The KPIT toolchains are now no longer supported by the www.kpitgnutools.com 
website. Support is now available from the www.gcc-renesas.com website. 
 
In addition, there are two new releases for the GNU toolchains for RX and RL78. 
These are now named Renesas GCC for RX and Renesas GCC for RL78. 
 
Both integrate into e² studio and can be selected from the project wizard. 
 

1922 Application Symptoms: Project fails to build in first instance after archive project import (not 
from HEW) 
 
Conditions: If an archived project is imported, it may fail to build the first time, 
due to a residual .d file. 
 
Workaround: Clean and Build a second time. 
 

2762 CODAN When using assembly code within a C source file, CODAN errors can be 
observed in the editor. Even though the project builds successfully, or even after 
rebuild index. 
 
Indexer buffer can be insufficient to process whole project. 
Please try giving larger values for the following configurations. 
 
Open preferences dialog through “Window”->” Preferences” menu. In “C/C++” -> 
“Indexer” tree, you will indexer configuration as shown below: 
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Put larger values for each red-framed variables, then rebuild project or rebuild 
index.  

2728 GDB Step into does not always work when using the CC-RX 1.02.01 toolchain. 
 
To ensure this behaves correctly you will need to use CC-RX 2.00.00 or greater 
as this issue with the debug information is corrected in this release. 
 

NA Eventpoints If eventpoints do not always work just after they are set, you can use the "Apply 
to Target" toolbar button in the Eventpoint view to send the Eventpoints to the 
target manually.  This will always ensure the debugger target has all the required 
eventpoint updates before execution starts. 
 

5772 IAR Plugins The IAR Plugin Manager is included in e² studio and provides support for RX, 
RL78, RH850 and RZ (ARM). 
 
This tool simplifies installation and configuration of IAR toolchain plugins. You 
can access this though Help -> IAR Embedded Workbench plugin manager. 
 

6184 RL78/CC-RL 
debugging 

When the load module for RL78/G10 which created at CC-RL is debugged in E1, 
please specify the following option: 

[Linker] -> [Device] -> "Set enable/disable on-chip debug by link option 
7217 Application The restore default settings does not restore all the options set during project 

generation.  Instead, it sets the defaults to the base settings for the device family 
in use. 

7524 RZ/T1 
Debugging 

In a RZ/T1 RAM-based project, the "Reload" function does not work. 

Reloading or re-downloading during debugging resets the device and the RAM 
content is erased. 

To continue the debugging, disconnect and connect the debugger again. 

 Use spaces 
as tabs 

Eclipse and CDT both have settings for use spaces as tabs. The option on the 
Editor preferences page conflicts with the CDT formatter settings. 

To change the use spaces as tabs option in e² studio please use this page: 
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 Installer 

problems 
In some situations, the AVG virus checker appears to interfere with the e² studio 
installation process. If you experience such a problem, please temporarily 
disable the AVG tool and try the installation again. 

 Antivirus In some situations, the Norton anti-virus tool can interfere with the building of 
Renesas Synergy projects. If possible, please disable the antivirus program 
when building Renesas Synergy projects on systems with Norton Antivirus 
installed. 

 Green Hills 
RH850 
Projects 

When debugging the RH850 object built with the Green Hills compiler in e2 
studio, specify the following option for the compiler option: 
-gtws 
 
The GUI setting menu is as follows. 

[GHS C Compiler for V800 Standalone]-[Debugging Option] 

     "Generate Target-Walkable Stack" -> On 

If this option is not specified, Step Over and Step Return may not work properly. 

17052 Debugging When debugging using a project with duplicate filenames that are in different 
source folders problems can be seen with breakpoint setting. 

When a breakpoint is set at a source line in this file it will also stop at the same 
source line in the other same named file when execution passes through. 

18505 RZ 
debugging 

When debugging with RZ/T1 in certain situations you may experience problems 
stepping: 

 
If the following conditions are met: 

  
1. Code is located close to address 0x0  
2. There is very little library code included into the project  
3. There are unused functions in the program  

The possibility arises that the code cannot be debugged. This due to --gc-
sections linker option which removes the unused functions but not the related 
debug information. 

There are several solutions to this problem:  
a. disable --gc-sections until those functions are used  
b. remove the unused functions 
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 RZ GCC 
Build 

In the latest e2 studio, the RZ import functionality has been improved. However, 
there are still possibilities of older projects causing problems when imported into 
e2 studio. 

In older versions of the RZ build plugins the FPU option was not being handled 
correctly. When setting the “Soft” Floating point ABI the command line was still 
receiving –mfpu=vfpv3 incorrectly. This can now cause problems with older 
start-up code in older RZ projects. 

After import if you see an error relating to this please add –mfpu=vfpv3 to the 
“Other Assembler Flags” page of the Assembler tool. 

In addition, when migrating some RZ/A1 projects you may experience import 
problems unless you build the project in 5.4 first. 

  

 RZ DS-5 
Project 
Import 

When a DS-5 project is imported into e2 studio the environment variables for 
Path and TCInstall are copied from the DS-5 environment.  
 
This is not correct. The way to correct this problem is to delete both paths and 
replace them with correct values to your toolchain. If you are unsure how to 
correct this, please create a new project and copy the values from this to the 
converted project.  

 RX & RL78 
GCC Project 
Import 

When importing a KPIT RL78/RX Library C/C++ project from e2 studio 5.4 or 
before the build artifact settings are not correct. 
 
The output prefix should be set to “lib” but is in fact empty. 
 

 RZ/G debug In the case of debugging Linux application for RZ/G, the following error 
messages are shown in GDB server console when pushing [Step in] button or 
[Step Over] button. 
These messages can be ignored because the Step debugging should work 
properly even with these messages. 
 
Examples of error messages: 
 PassthroughTargetCommunication::sendResponse error 42 46 
 PassthroughTargetCommunication::sendResponse error 10 15 
 PassthroughTargetCommunication::sendResponse error 42 46 

21863 RX & RL 
Debugging 

In previous releases there were some problems with stepping in some situations 
when using the CCRX and CCRL toolchains. 

 

A fix has been made to the debug object converter. To see this improvement 
please clean and rebuild the project. The debug information will then be 
updated, and the stepping will be more correct and reliable. 

 Code 
Generator 
registration 

When using multiple installations of e2 studio on your machine you may find that 
subsequent installations do not work correctly with the code generator. 

The effect is that the code generator cannot be created or added to projects. 
Existing projects can be used by the code generator views appear empty. 

If this is the case, then the code generator must be manually registered. To do 
this execute the following tool: 

e.g.  
C:\Renesas\e2_studip\eclipse\plugins\com.renesas.cg_2.11.0.v20180
601-1047\CodeGenerator\Tools\register COM.bat 
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25278 Synergy 
debugging 

When loading Symbols from multiple .elf files compiled using the IAR toolchain, 
the user will need to add  ".text" before  place in FLASH_region command inside 
the .icf Script.  

e.g.  
".text":  
place in FLASH_region   { block LOCK_LOOKUP, 
               ro, 
               ro section .rodata, 
               block QSPI_NON_RETENTIVE_INIT_BLOCK, 
               block RAM_INIT_CODE, 
               block USB_DEV_DESC_BLK }; 

25273 RZ Device 
Migration 

When changing the device from a RZ/A1 and attempting to swap to a RZ/T1 the 
device migration is not successful. 
 
The source code is not migrated successfully, and the build fails. 
This is due to the different start-up code structure between these devices. 
 
In this case please create a new project and copy the required source to the 
newly created project. 

25195 RZ/A2M 
Smart 
Configurator 

When creating a project of RZ / A2M, the following Warning is displayed in the 
Problems view for the src / renesas / configuration folder. 
    "Invalid project path: Include path not found" 
 
[Workaround] 
Delete the specification of this folder with the compile option include path setting. 

24883 R2/A2M RZ / A2M project generated by e2 studio does not support GCC ARM 7.x or 
later. Please use GCC ARM 6.3. 

27913 GDB server 
RL78 

When debugging with an EZ cube, real-time refresh significantly slows down 
debugging features and it makes e2 studio look like suspended. 

12123 Linker Script 
Editor 

The Linker Script Editor may report errors when using some Wild Identifiers such 
as 1file.o and *filename.o.. 

Although these are valid file names and valid identifiers according to the Linker 
Script syntax, they need to be quoted when using the Linker Script Editor. 

(e.g. "1file.o" and "*filename.o"). 

 RZ/G Linux 
Platform 
Tools 

When using RZ/G Linux Platform Tools, gnu.io.rxtx plug-ins should be installed 
same as Nebula plug-ins.  

Please follow the below steps to install gnu.io.rxtx plug-ins. 

 

Start the e2 studio and select [Help] -> [Install New Software] from the menu bar 
to open the [Install] dialog box.  

Click on the [Add] button, enter “GNU RXTX Plugin Update Site” as a name 
and“http://rxtx.qbang.org/eclipse/” as a location, and click on the [OK] button. 

http://rxtx.qbang.org/eclipse/
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Select [RXTX 2.1-7r4] -> [RXTX End-User Runtime] from the list, click on the 
[Next] button, confirm the license, and install the plug-ins. 

 
 

32564 MyRenesas Due to differences in the login data between 7.8 and the 2020-04 e2 studio (or 
later) version the FreeRTOS download feature does not work in 7.7/8 if the user 
has logged into MyRenesas or changed their login data details using 2020-04. If 
you previously used 7.7/8 prior to using 2020-04 and have not changed your 
login details, then both versions will work correctly.  

If you need to use MyRenesas in older versions of e2 studio after logging in 
using 2020-04 then you will need to close all e2 studio instances and delete the 
file "%USERPROFILE%\.eclipse\org.eclipse.equinox.security\secure_storage". Be aware 
that doing this will remove stored passwords for any Eclipse-based application. 

32543 QE When updating e2 studio versions using an installer any installed QE tools are 
removed and then must be reinstalled. To preserve QE tools during an update 
use the "Check for Updates" function in the "Help" menu to perform an in-place 
online update. 

30689 J-link It is now possible to configure J-Link to select a remote IP name or address. 

 However currently the user interface does not support this feature.  

It can be supported by adding extra commands in the debug configuration. 
Under the Jlink section in the Debug Connection settings you can select USB or 
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IP. If IP is selected, then you will need to specify an IP address/name and 
optionally a port number.  

GDB Server expects the command line parameter (examples):  
-uSelect= IP=192.168.56.1:8080 -uSelect= IP=localhost:0 -uSelect= 
IP=jlink.segger.com    

30613 RH850 When viewing flash memory in the Memory View, it can be confusing as the 
values for this memory type can be random for unwritten blank flash memory 
regions.  

This can then result in many false positives for memory changes, resulting in 
more memory changes than expected. (red text)  

To fix this the debugger supports detection and filling of blank addresses areas 
with a user specified hex byte value.  

There is currently no user interface support for this feature. So, you need to add 
the following command parameters to the additional commands section of the 
debug configuration. The GDB command line option is: -uBlankFlaskFill=BB 
with the blank fill value being 0xBB. Specifying this value enables the feature, by 
default it is off. 

33914 RE Program does not step correctly for RE (SOTB) when library generator enabled.  
 
Selecting an ARM GCC toolchain that has libgen installed when creating a new 
project, will cause the program to go to the default handler when stepping, after 
returning from function on SOTB board. There are 2 workarounds for this: 
 
1. Use a toolchain that does not have libgen installed 
2. Choose the options: Project-built, Optimized for Library Generator when 
creating the project and change the selected options to Pre-built, Newlib after 
the project was created, by going to Settings->Library Generator. 
 

37443 RA (Linux) CMSIS Pack Import feature does not work for RA on Linux 
37531 RA The quick link for RA project creation available on the File->New menu item has 

been removed. You can now access the RA Project Generator via the New-
>C/C++ Project menu item. 

37261 All In Memory view (Image View rendering), when user gives input images and 
decodes it with ARGB 8888 format. Output image color is not as same as input 
image. 

36999 RA Deleting the Debug folder from an NS project causes build failure when 
reference NSC guard functions. 

36007 RA When debugging a secure and non-secure project - the Non-secure callable 
functions do not have debug information. 
This means you cannot set breakpoints in the secure function. 

35767 RA, RZ 
(Linux) 

When importing an image using the "Image" Rendering on Linux Host the action 
fails. If you need to import an image on Linux please use the Raw Image 
memory rendering instead. 

38324 RA When upgrading an e2 studio 2020-04 or 2020-07 containing RA Family support 
to 2020-10 using the installer you may encounter on the features page. 
 
To avoid this, you either need to re-select RA on the Device Family selection 
page or uncheck and check again "Renesas FSP Smart Configuration Core" on 
the Features page. 
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6. Linux version - How to install 
Installation steps of public beta version e2 studio for Linux 

A. Download archived file from download page. You can find the download page by visiting the e2 studio 
product information web page (https://www.renesas.com/e2_studio) and then click the ‘Download the 
installer’ button. Once completed enter the text ‘e² studio 2020-04 for Linux, public beta edition’ in the 
search text box and press “Search”. Then you can select the download from the found items list. 

B. Extract the downloaded archived file (extension *.7z) into local storage. 
C. Please ensure that the Linux distribution you are using also has Python3 installed. 

 
6.1.1 Segger driver installation 

To use the Segger J-Link tools with e2 studio the required Segger drivers and toolset should also be installed. 

For Ubuntu, download the 64-bit DEB version from the Segger website 

• https://www.segger.com/downloads/jlink/ 

Follow the instructions from Segger or run: 
sudo dpkg -i JLink_Linux_Vxxx_x86_64.deb  

(replace filename with the file version of the deb package your just downloaded) 

 

6.1.2 FSP installation 
Install RA FSP packs as follows (depending on e2 studio install folder and FSP pack): 
cd /opt/e2studio 

sudo unzip ~/Downloads/FSP_v1.0.0.zip 

FSP needs to unzipped to the location as follows: 
 /home/<user>/.eclipse/com.renesas.platform_<version> 

<user> is replaced by the user name. 

<version> is replaced by the com.renesas.platform version. 

  

https://www.renesas.com/e2_studio
https://www.segger.com/downloads/jlink/
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6.2 How to run 
A. Run ‘terminal’ application of Linux. 
B. Move installed directory and Run ‘e2 studio’ binary file. 

6.3 Register toolchain to e2 studio 
6.3.1 GNU ARM Embedded 

Install the GNU ARM Embedded toolchain to a shared folder as follows: 
sudo mkdir -p /opt 

cd /opt 

sudo tar jxf ~/Downloads/gcc-arm-none-eabi-7-2018-q2-update-linux.tar.bz2 

(assuming the toolchain has been downloaded to your Downloads folder) 

On first invocation you will be prompted to specify a workspace location, you will also be advised that there 
are no new toolchains available for integration. Open the Renesas Toolchain Management preference page 
using the Help → Add Renesas Toolchains menu item, then click on the Add... button and navigate to the root 
folder of the GNU ARM Embedded toolchain installation at /opt/gcc-arm-none-eabi-7-2018-q2-update in order 
to register the toolchain with e2 studio: 
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6.3.2 Linaro 
A. Download and extract a toolchain package file to arbitrary directory. 
B. Run ‘e2 studio’ and select ‘Help – Add Renesas Toolchains’ 
C. Select ‘Toolchain Type’ and ‘Add’ Location of toolchain. 

 

 
Figure 2.   Register Toolchain: Browse toolchain location 

D. Click checkbox of added toolchain and restart e2 studio. 

 
Figure 3.   Register Toolchain: ex) Linaro  
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6.4 How to build and debug RA applications Overview 
6.4.1 Build 

Open the New project wizard and chose an RA project. 

If this is unavailable it is likely the FSP has not been installed correctly. In this case, quit e2 studio,  reinstall the 
pack(s) and restart e2 studio again 

Once the wizard completes a sample project will have been created, as well as a debug configuration for 
connecting the debugger. 

6.4.2 Debug 
Once the project has successfully built and produced a build artefact for debug, open the Debug Configurations 
dialog and a browse to the Renesas Hardware Debug section 

The debug configuration will match the project name – check that the settings are correct and hit Debug to 
connect to the device. 

(1) Checks if connection fails 

If the debug connection fails it is often for one of two reasons: 

1. If using a virtual machine make sure that the device is tied into the VM rather than the host machine. 

2. If the Segger library has not installed as part of the FSP correctly open the 
“/home/user/.eclipse/com.renesas.platform_XXXXXXX/DebugComp/RA/ARM/Segger” folder and 
copy and paste the 'libjlinkarm.so' into the other Segger folders - e.g. 'Segger_v6.50.1’. Alternatively, 
take the latest file from the Segger Tools installation folder and install to the same place. 

 

6.5 How to build and debug RZ Linux application Overview 
Public beta version e2 studio for Linux supports building and debugging Linux applications for devices of RZ/A 
Group and RZ/G Group. For debugging by GDB (the GNU Project Debugger), please add Linux programs gdb-
server program to Linux file system of devices and run as background process automatically. (ssh-server, tcf-agent 
will be needed for connection between host system and target device.) For detail about building Linux image for 
RZ family devices, refer to embedded Linux wiki pages (https://elinux.org) or Renesas Rulz web pages about RZ 
family (https://renesasrulz.com/rz). Descriptions in below is based on RZ/A1H case. 

6.5.1 How to add gdb-server to RZ/A Linux root file system 

https://elinux.org/
https://renesasrulz.com/rz
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A. Build root file system of RZ/A1 Linux-4.9 BSP. 
(path example: ~/rza_linux-4.9_bsp/, command example: ./build.sh buildroot) 

B. Move to ‘buildroot-***’ directory in ‘output’. 
(path example : ~/rza_linux-4.9_bsp/output/buildroot-2017.02) 

C. Run menuconfig (make menuconfig) and add gdb-server.  
(Select ‘Toolchain－Copy gdb server to the Target’ menu) 

 
Figure 4.   Menuconfig: set ‘copy gdb server to the target’ 

 
D. Move to ‘target’ directory in ‘output’ of ‘buildroot-****’.  

(path example: ~/rza_linux-4.9_bsp/output/buildroot-2017.02/output/target) 

E. Add new file with a line as command at ‘/etc/init.d’ directory 

 
 

F. Delete or disable below contents from etc/inittab. 

 
 
G. Move ‘Linux-4.9 BSP root’ (path example: ~/rza_linux-4.9_bsp/) and build root file system again. Download 

root file system at target device.   

File name: S51gdbserver 

Command: /usr/bin/gdbserver --multi --remote-debug /dev/ttySC0 

# Put a getty on the serial port 

# ttySC0::respawn:/sbin/getty -L ttySC0 115200 vt100 # GENERIC_SERIAL 
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6.5.2 Linux C/C++ Project generation and build 
A. Connect target device which is run as Linux, via Serial port.  
B. Select ‘File – New - RZ Linux C/C++ project’ menu and make new RZ/A1H Linux C/C++ project. In phase 

of ‘RZ Linux connection settings’, the serial port which is used for connecting target device, will be selected 
automatically.  

 
Figure 5.   New RZ Linux project & connection setting: Serial port 

C. After editing codes, build by selecting ‘Build Project’ in right-click menu or push   button.  

 
Figure 6.   Build Project 

 
  



e² studio 2020-10 Release Note 

R20UT4838EG0100 Rev.1.00  Page 50 of 54 
September. 23rd, 2020  

6.5.3 GDB debug by using serial port communication  
A. Terminate all processes use serial port communication such as Minicom. 
B. Open ‘Configuration’ and check ‘Serial’ is selected as ‘Connection’. 

 
Figure 7.   Connection configuration: Serial 

C. Run debug by push button    . It takes 10 or more seconds for transferring binary files to target device. 
Pop up message for switching to debug perspective will be shown after transferring binary files. 

 
Figure 8.   Debug: Perspective Switch 
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D. ‘Debug Perspective’ provide ways for flow controls and configurations. This public beta version e2 studio for 
Linux doesn’t have console view for showing result of the program. 
 (Under development) For more detail, please see user manuals of e² studio Windows edition. 

 

 Figure 9.   Debug: Control buttons, views, setting break point 
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7. Open Issues in 2020-10 
 
Open issues in the e2 studio 2020-10 product will be kept up to date here: 
 
Please visit to see the latest open issue list. 
  

https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio8/docs/releasenotes/2020_10/openissues.htm
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8. Appendix 
8.1 Website and Support  
Renesas Electronics Website 

http://www.renesas.com/ 
 
Inquiries 

http://www.renesas.com/contact/ 
 

8.2 Web Access and Privacy Policy 
Collection of User Information Applications included in this package may access the Renesas Web site. In such cases, 
the following information is collected and recorded to Renesas server as a log. 

• Date and time of access 

• Access to URLs and files 

• The unique certificate number linked to your account for MyRenesas (only when you log in to MyRenesas) 

• The unique identification number linked to cookies for the Web browser (for cookies, refer to the privacy policy page 
stated below). 

Logs are managed based on our privacy policy. 

Refer to our privacy policy on the following Web page. 

Privacy Policy: 

https://www.renesas.com/privacy.html 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.renesas.com/
http://www.renesas.com/contact/
https://www.renesas.com/privacy.html
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All trademarks and registered trademarks are the property of their respective owners. 
 

“FreeRTOS™ is the trademark of Amazon Web Services, Inc. 

AWS™, Amazon Web Services™ is the trademark of Amazon Web Services, Inc.” 

GITHUB® is the trademark registered in the United States by GitHub, Inc. 
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1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
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and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 
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each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
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6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 
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